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Introduction

While dealing with numbers, which we all do in one way or another, we need
a systematic process of calculating those numbers—Iike comparing our
expenditure to our income, understanding our day to day expenses, etc. To be
able to spend wisely, we need to be able to handle our expenses with respect
to the income that we receive.

That is exactly where Microsoft Excel comes into picture, giving us the help
we need to analyze, record, and store numerical data. Microsoft Excel was
introduced in 1985, and instantly won the hearts of people in all types of
fields, in particular the business sector.

It is a highly useful and user-friendly software that works with spreadsheets
to perform both simple and complex calculations. It analyzes numeric data
which can then be used to make predictions for future costs or turnovers.

Excel is a spreadsheet with a collection of rows and columns that form a
table. Alphabetical letters are used for columns, while numbers are allocated
to rows. A “cell” is the point where a row and column meet. The spreadsheets
are operational in any direction and not limited to calculations. They also
help to create and manage tables, produce forms, as well as develop custom
programs and functionalities.

Microsoft Word, on the other hand, is a word processing program developed
by Microsoft that was first released on October 25, 1983. Since then, many
versions have been released, and it has been a consistent favorite owing to its
easy to understand and highly usable features. It can be used by anyone, but
is especially popular among students for writing essays and assignments.

This book focuses on learning about Excel, but is not limited to Excel alone.
It will demonstrate steps that apply to the latest (as of writing) version of
Excel, that is, Microsoft Excel 2020. The steps are also appropriate and
useful for Excel 2007, 2010, 2013, 2016, and 365. The newly added functions
of Excel can be found in this book, with an explanation, and some overview
of the older ones.



Although we will learn about Microsoft Excel, this book will also give you,
the reader and learner, a brief history about Microsoft, and some basics of
Microsoft Word. The practical understanding of Excel spreadsheets will help
you significantly in the long run.

Whether you are a student or a professional writer, the uses of Microsoft
Word are almost unlimited. You can write projects, books, detailed
documents, and more with such convenience. The ease with which you can
learn about Microsoft Word and then apply its principles to your daily tasks
makes it the ideal starting point. It will help you to keep all the information
you need in a proper format, with features like tables, charts, and more that
you will read about in this book.

It also gives a brief history of and facts about Microsoft. You’ll learn about
all the hardships and challenges that Microsoft faced before reaching the
epitome of success. Microsoft has truly made our lives easier.

Finally, this book attempts to reveal the foundation of Microsoft Office
applications such as Word and Excel. This informational book will be handy
for anyone, whether you’re a student, business professional, or stay-at-home
parent. The usefulness of Microsoft Office applications cannot be
understated. Let’s dive deep into the basics and also learn some tips and
tricks to make our use easier.

The best way to learn from this book is to sit at a computer or device while
learning the basics, in order to apply and properly retain all the information.



Chapter 1: Microsoft - A Brief History & Facts

How it Started

In 1975, Bill Gates and Paul G. Allen, two childhood friends from Seattle,
turned a common mainframe computer programming language (called
BASIC) into something they could use on a personal computer called the
Altair. Very quickly after that, Gates and Allen founded Microsoft, the name
being derived from the words “microcomputer” and “software”. For the next
few years, they refined BASIC and developed other computer programming
languages.

The International Business Machines Corporation (IBM), in 1980, asked
Microsoft to produce the operating system and the essential software for its
first personal computer, the IBM PC. Microsoft bought an operating system
from another company, remodeled it, and named it MS-DOS (Microsoft Disk
Operating System). MS-DOS was released along with the IBM PC in 1981.
Shortly thereafter, most manufacturers of personal computers had licensed
MS-DOS as their operating system, which generated vast revenues for
Microsoft; by the early 1990s Microsoft had sold more than 100 million
copies of the program and crushed rival operating systems such as CP/M,
which it displaced in the early 1980s. Microsoft also later displaced IBM
0S/2.



How it Gained Momentum

Microsoft largely deepened its position in operating systems with Windows, a
graphical user interface whose third version, which was released in 1990, had
gained a wide following. By the year 1993, Windows 3.0 and its other
subsequent versions were selling at a rate of one million copies per month,
and almost 90 percent of the world’s PCs ran on a Microsoft operating
system.

In 1995 the company released Windows 95, which for the first time fully
integrated MS-DOS with Windows and effectively matched the ease of use of
Apple Computer’s Mac OS. Microsoft also became the leader in productivity
software such as word-processing (MS WORD) and spreadsheet (MS
EXCEL) programs, overtaking their longtime rivals Lotus and WordPerfect
in the process.

Microsoft eventually expanded its “electronic publishing division” which was
created in 1985 and already notable for the extreme success of its multimedia
encyclopaedia called “Encarta.” It also entered the information services and
entertainment industries with a wide range of services as well as products,
most notably the Microsoft Network and MSNBC (a joint venture with the
National Broadcasting Company, a major American television network which
began in the year 1995 and ended in 2012).

As a result, by the mid-1990s Microsoft, which had become a publicly owned
corporation in 1986, was one of the most powerful and profitable companies
in American history. It consistently earned profits of 25 cents on every sales
dollar, which was an astonishing record. In the company’s 1996 fiscal year, it
raised more than $2 billion in net income for the first time, and its
unparalleled string of profits continued, even during the Great Recession of
2007-09 (its net income had outgrown to more than $14 billion by the fiscal
year 2009).



How it Grew

Microsoft’s rapid growth in a strong and fiercely competitive and extremely
fast-changing industry obviously increased resentment and jealousy among
rivals, some of whom complained that the company’s practices violated U.S.
laws against “unfair competition.” Microsoft and its defenders countered that,
as far as competition and technical innovation were concerned, its rise had
encouraged both and its software had consistently become less expensive and
more useful. A U.S. The Justice Department investigation concluded in 1994
with a settlement in which Microsoft changed some sales practices that the
government contended enabled the company to unfairly discourage OS
customers from trying alternative programs. The next year, the Justice
Department had successfully challenged Microsoft’s proposed purchase of
Intuit Inc., which was then the leading producer of financial software for PCs.

Partly because of its stunning success in PC software, Microsoft was slow to
realize the commercial possibilities of network systems and the Internet. In
1993, it released Windows NT, a landmark program that tied disparate PCs
together and offered improved reliability and network security. Sales were
initially disappointing, but by 1996 Windows NT was being hailed as the
likely standard for PC networking, quickly surpassing Novell’s NetWare in
market share.

Microsoft did not move into Internet software until a new venture, Netscape
Communications Corp., had introduced Navigator, a Web browser program
that simplified the once-arcane process of navigating the World Wide Web.
In a violent change of course, Microsoft quickly developed its own browser,
Internet Explorer, made it free, and moved aggressively to persuade computer
makers and Internet service providers to distribute it exclusively. By 1996,
Microsoft was bundling Explorer with Windows OS and had begun the
process of integrating Explorer directly into Windows. In response, Netscape
accused Microsoft of violating its 1995 consent decree and sued. Those
efforts helped to persuade the Justice Department to reopen a broad
investigation on Microsoft.



Legal Matters Faced by Microsoft

In 1999, following a trial that lasted 30 months, a judge found Microsoft in
violation of the Sherman Antitrust Act (1890) and ordered the company to
break up. In 2001, an appeals court overturned the breakup order but still
found the company to be guilty of illegally trying to maintain a monopoly.
The company’s legal struggles continued in 2004: the European Union (EU)
levied the largest fine in the organization’s history to that point, €497.2
million, in retaliation for what were described as Microsoft’s near-monopoly
practices. In February of 2008, the EU imposed an even higher fine, €899
million, on the company for having defied the EU’s 2004 antitrust decision
against Microsoft for illegally bundling multimedia software with its
Windows operating system to the exclusion of competitors, which was
considered unfair.



Gaming & Other Products

In 2001 Microsoft released the Xbox, an electronic game console that quickly
captured second place in the video gaming market. In 2002 it launched Xbox
Live, a broadband gaming network for its consoles. A more powerful gaming
console, the Xbox 360, was released in the year 2005.

In an extremely competitive market, where Xbox faced strong pressure from
the Nintendo Wii and Sony PlayStation, Microsoft struggled through the
years to make consistent profits from its console. For example, in 2009 the
company cut the price of the Xbox 360 Elite by as much as 25 percent so that
it could pick up market share. The move was successful; by 2010 the Xbox
360 was the most-used game console in the American household. At the same
time, the price cuts also led to a 6 percent drop in the revenue of Microsoft’s
Entertainment and Devices Division (EDD). The Xbox 360 was succeeded in
2013 by the Xbox One, which in turn was replaced by the Xbox Series X and
then the Xbox Series S in 2020.

Other EDD products also struggled. The Zune family of portable media
players introduced in 2006 failed to challenge the market dominance of
Apple’s iPod, and was discontinued in 2011. The Windows Mobile Operating
System, used in smartphones made by a variety of vendors including HTC,
LG, Motorola, and Samsung, trailed in market share in the United States
behind Research in Motion’s BlackBerry and Apple’s iPhone. Then, in 2009,
Microsoft ceased publishing online and disc versions of its Encarta
encyclopaedia.



Challenges & Overcoming them

In the same year that Microsoft first released the Xbox, it began planning a
major replacement for all of its operating systems. The project, code-named
“Longhorn”, encountered many delays, in part because of efforts to address
the public’s constantly growing concern with computer security and
consumer desire for PCs to have greater integration with a full range of
entertainment equipment within the modern electronic home. The company
started over again, and the new operating system, renamed “Vista”, was
released to other software developers late in 2006, and to the rest of the
public in 2007.

Like most new operating systems, Vista met with initial problems involving
incompatibilities with older computers. More problematic for the new
operating system was its “bloated” structure, which required a very fast
microprocessor and large amounts of dedicated computer memory for proper
functioning. The need for excessive system resources deterred many
companies and individuals from upgrading systems from earlier, and
perfectly serviceable, systems such as Windows XP, which derived from the
term Windows Experience. To add to this, consumers were taken aback by
the numerous Vista options: Home (Basic or Premium), Ultimate, Business,
and others. Meanwhile, business users, Microsoft’s core market, balked at its
major change to the user interface and were unwilling to port their internal
applications to the new system.

Microsoft’s corporate users had many other reasons to stick with Windows
XP. Though still much more problematic compared with other operating
systems, XP was significantly more secure than its predecessors. XP was also
much faster and more stable than Windows 95 or 98, and it ran thousands of
software programs which were written specifically for it, making business
users reluctant to switch operating systems. It can be a point of argument that
customer satisfaction with XP is what killed Vista among business users.
Personal computer makers, who were contractually required by Microsoft to
ship products with Vista, were compelled to offer “downgrades” from Vista



to XP, and user appreciation even compelled Microsoft to extend its official
support of the older Operating Systems through 2014, three years beyond its
normal support policies.

Adding to Microsoft’s OS problems was the ever-increasing competition in
the marketplace. Apple’s Mac OS X, riding on the huge success of the iPhone
and iPod consumer products, grew tremendous popularity. Linux, long an
operating system for the technically adept, started to appear in more user-
friendly versions, such as Ubuntu, and by the end of the first decade of the
21st century, Linux had held one-third of the growing low-cost netbook
markets.

Despite its problems in the marketplace, Microsoft remained the more
dominant supplier of operating systems. Windows has held a global market
share of 86 to 92 percent, depending on the research analysis. With the
release in 2009 of Windows 7, the replacement for Vista, to critical praise by
reviewers and analysts, Microsoft’s lead remained intact. In 2012, the
company released Windows 8, which offered a start screen with applications
appearing as tiles on a grid. Windows 10, released in 2015, featured Cortana,
a digital personal assistant capable of responding to voice commands, and a
new Web browser, Microsoft Edge, which would replace Internet Explorer.

In 2000, company cofounder Gates relinquished his role as CEO of Microsoft
to Steve Ballmer, whom he had met during his brief tenure at Harvard
University in the 1970s. He handed over the title of chief software architect in
the year 2006 to Ray Ozzie, a chief developer of the computer networking
package Lotus Notes in the 1990s. In 2008 Gates left the day-to-day running
of the company to Ballmer, Ozzie, and other managers, though he remained
as the chairman of the board. Ozzie stepped down in 2010, and longtime
Microsoft executive Satya Nadella replaced Ballmer as CEO in 2014.

There was some concern, along with some hopefulness, among industry
observers, that the departure of Gates would hamper Microsoft’s preeminent
position in the computer industry. That situation did not materialize. The
company retained its top spot in both business and consumer parts, including
operating systems, productivity software, and online gaming services. In
2012, it introduced Surface, a line of hybrid tablet computers with hardware
designed by Microsoft itself, which was a first for the company. It also had



competitive products in almost all areas of business information technology
and applications.

Microsoft’s core strengths and most of its profits were to be found on its
business side of the industry, where it set global standards with its products
and services. Nevertheless, Microsoft’s management understood that the
company also had to have a major, if not an extremely dominant, presence in
consumer markets as improvements in information technology continued
blurring the line between personal computing and business computing.



Chapter 2: Introduction to Microsoft Office

Microsoft Office is a collection of applications that are office related. Each
application in MS Office has a unique purpose and offers a very specific
service to its users. For example, Microsoft Word is used to create
documents. Microsoft PowerPoint is used to create presentations. Microsoft
Outlook is used to manage and send emails and calendars. Microsoft Excel is
used to make spreadsheets, which we will learn how to use in this book.

The latest version of Microsoft Office is called Microsoft Office 2019 (which
will be succeeded by Microsoft 2021 in the second half of 2021), although
the web-based Microsoft 365 is the version that Microsoft would always
prefer users to adopt. Various versions of the suite have been around since its
inception in 1988, including but not limited to Microsoft Office Professional,
Microsoft Office Home and Student, and various other collections of
Microsoft Office 2016. Most people still refer to any version of the suite as
Microsoft Office, which makes differentiating among its editions much more
difficult.

The thing that makes Microsoft 365 stand out from older editions of MS
Office is that it integrates all aspects of the applications with the cloud. It’s a
subscription service too, which means users will pay a monthly fee or yearly
fee to use it, and upgrades to the newer versions are included in this price.
Previous versions of Microsoft Office, including the version Office 2016,
didn’t offer all the cloud features that Microsoft 365 does and were not
subscription-based. Office 2016 was a one-time purchase, just as other
editions were, and as Office 2019 is.

Microsoft 365 Business comes in four different packages: Basic, Standard,
Premium, and Applications.

Basic includes web and mobile versions of Word, Excel, and PowerPoint.
Standard adds Publisher and Access (Personal Computer only). Premium
adds all cloud services such as Intune and Azure Information Protection.
Apps include all Standard applications and OneDrive.

Users who purchase a Microsoft Office suite typically do so when they



discover that the apps included with their operating system aren’t robust
enough to meet their needs. For example, it would be nearly impossible to
write a book using only Microsoft WordPad, the word processing app that is
included free with all editions of Windows. But, it would certainly be feasible
to write a book with Microsoft Word, which offers many more features.

Businesses also use Microsoft Office because of the convenience. It’s the
standard among large corporations. The applications included in the business
suites include those that can be used to manage large databases of users,
perform advanced spreadsheet calculations, and create powerful and exciting
presentations, complete with music and video. Microsoft claims that over a
billion people use their Office products.

You can access everything Microsoft Office has to offer on most devices
including desktops, laptops, tablets, and smartphones.

If you don’t have a computer or the one you have doesn’t support a full
version of Office, you can use the Microsoft Office Online suite of
applications at your convenience.

There are applications for Microsoft Office for the iPad and iPhone as well,
all of which are available from the App Store. Applications for Android are
available from Google Play.

The apps included in a specific Microsoft Office suite depend on the
Microsoft Office package you select (as does the price). Microsoft 365
Family and Personal include Word, Excel, PowerPoint, OneNote, and
Outlook. Office Home & Student 2016 (for Personal Computers only)
includes Excel, Word, PowerPoint, and OneNote. The Business Suites have
specific combinations as well and include Publisher and Access.

Here’s a short description of the applications and their purposes:

e Word is used to create documents, flyers, and publications.

e PowerPoint is used to organize and manipulate data including formulas,
graphing tools, and more.

e Excel is used to store, organize, and manipulate data.

e OneDrive is used to store data online.

e OneNote is used for organizing data you collect including handwritten
notes, drawings, screen captures, audio clips, and more.



e Publisher’s purpose is creating extensive publications, posters, flyers,
and menus.

° Outlook is used to manage email and calendars, to do lists, and
contacts.

® Access is used for compiling and organizing large amounts of data.

Microsoft has designed the applications in the suites to work together
seamlessly to make life easier. If you take a look at the list above, you can
imagine how many combinations of applications can be used together. For
instance, you can write a document in Word and then save it to the cloud
using OneDrive. You can write an email in Outlook and then attach a
presentation that you’ve created with PowerPoint. You can import contacts
from Outlook to Excel to create a spreadsheet of the people you know, their
names, addresses, and so on that can keep all of your information in one
single place.

All Mac versions of Microsoft 365 include Outlook, Word, Excel,
PowerPoint, and OneNote.

The Android version includes Excel, Word, and PowerPoint as a unified
application; Outlook and OneNote are separate apps. Word, Excel, and
PowerPoint can also be downloaded separately for Android.

The iOS Version of Microsoft includes Excel, Word, PowerPoint as separate
applications or as a unified Office application, while Outlook and OneNote
are separate applications only.



Chapter 3: Excel and Its New Features

Excel is an application that uses spreadsheets to organize numbers and data
with various formulas and distinctive functions. It entails features like
calculation, charts, pivot tables, etc.

The latest version of Excel, which is the 2020 version, provides a vast
collection of improved features and various other capabilities, making it
easier to use, along with more reliability, making it much better in terms of
organization.

A few new features are listed below.



Automated Workflow

The updated version of Excel 2020 will now connect better to Microsoft
Flow, which allows you to create automated workflows, wherein data is
recovered from other applications and saved or changed in Excel. This data
flow can be programmed to send or share the data with third party
applications or people, automatically. Flow can recover your data from
anywhere at all, for instance, your accounting system, CRM system, stock
price database, weather forecast databases, email server, and much more.



3D Images

Excel 2020 can now embrace new imaging (3D imaging) capabilities wherein
you can rotate a 3D model of any object. This new updated version contains a
bunch of 3D images that are accessible from the “Insert” tab’s “3D models”
option. Some categories include letters, gadgets, diorama, animals, space,
geology, biology, electronics, and much more.



Data Import Tool Improvement

Renamed from The Power Query in Excel 2013, to Get & Transform in Excel
2016, the name has once again been renamed to ‘The Power Query’ in the
latest version of Excel 2020. This tool provides the capability to import data
from external sources and then get the data cleaned by placing it in Excel.
Some of these skills include the ability to group data, transpose data, detect
data types, parse data, reverse rows, merge columns, replace values, split
columns, unpivot columns, rename column headings, and create conditional
columns. With the help of this feature, it becomes easier, faster, and more
precise to be able to import data from external sources for manipulation of
data and its analysis in Excel.



Custom Functions

Excel 2020 now permits its users to create their custom functions using
JavaScript. Earlier versions of Excel had already enabled users to be able to
create user-defined functions by using Excel’s built-in Visual Basic for most
applications’ programming language. Since JavaScript has emerged as a
frequently-used platform for these purposes, Microsoft has added this new
feature to allow excellent compatibility with third-party solutions.



Custom Visuals

For delivering more visual ways to display and present your data, Microsoft
has merged its Power BI suite of applications into Excel 2020. Most of these
add-on applications are available for free, but some are priced from $1.49 to
$13.99, while others have payment prices that range from $1.49 to $5.99 per
month. The add-on applications include Word Cloud charts, Speedometer
charts, Bullet charts, and Supermetrics, to name a few.



New Functions

There are six new and improved functions which are as follows: IFS,
CONCAT, SWITCH, TEXTJOIN, MINIFS, and MAXIFS. While IFS and
SWITCH are simplified versions of the nested IF functions that eliminate the
need for more complicated nested functions, the TEXTJOIN function is a
simplified version of the CONCATENATE function, in which text that is
inserted need not be captured by quotation marks. The CONCAT function
allows you to merge text from multiple cells without stipulating a delimiter.
The MINIFS and MAXIFS features work like the SUMIF or COUNTIF
functions, calculating only the minimum or maximum for those data that
meet the criteria that you stipulate.



Over 500 New Built In Icons

Excel 2020 now offers new built-in SVG-compliant icons for creating
dashboards and infographics.



Map Chart Improvements

New options allow you to project your maps in Miller, Albers, or Mercator
layouts, which means that you can display your map charts as flat or curved.
New controls can also be chosen for choosing the map area that is to be
shown.



Chart Improvements

New choices in Excel 2020 will allow you to control better axis information
on your flow charts, such as number formats and tick marks, and you can
now also produce some color-coded heat maps.



Co-Authoring

The new co-authoring ability will enable you to share your workbook with
other third-parties, enabling several users to edit the same workbook at the
same time as you when your file is stored on either the SharePoint or
OneDrive platform. It also allows you to set permissions for your
collaborators.



New Themes

Excel 2020 now offers you three Office themes that you can choose and
apply: colorful, dark grey, and white. To get access to these themes, you have
to go to File, Options, General, and click on the drop-down menu which is
next to Office Theme.

These newer and more advanced features of Excel 2020 are very useful, and
to use them correctly, we need to understand the other basic features of Excel
in general. Only then will these features be properly understood and used to
their fullest capabilities. There are many other basic features of Excel that
will be slowly understood in each chapter of this book.



Chapter 4: Excel Terminologies

For better understanding of Excel and its uses, we have to first understand the
basic terminologies of it, and what it consists of. Mentioned below are the
basic terms you will need to know in order to fully comprehend the

functionalities of Excel.



Workbook

The Excel spreadsheet file is referred to as the “workbook”. The workbook
stores all the data that you have put in or entered, which in turn lets you
calculate or sort the results the way you want. A workbook that can be
accessed by multiple users (third-parties) to view or modify on a specific
network is called a Shared Workbook.



Worksheet

A sub-component document of a workbook is called a worksheet. Also
known as spreadsheets, you can work on multiple spreadsheets or worksheets
in a single workbook.

The tabs at the bottommost of your screen indicate which of the worksheets
you have created you are currently working on. That is also known as an
active spreadsheet or an active worksheet.



Cell

The intersection between a column and a row on a spreadsheet is known as a
cell. Each cell, on any given worksheet, can contain any value that can be
called using a virtual cell reference or called upon using a formula. Any
specific data that you want to add to your spreadsheet has to be put into a
cell. The cell that you are currently working on or editing in is called an
active cell.



Column and Rows

Your cells are aligned in columns and rows. Rows are aligned horizontally,
while columns are aligned vertically.



Column and Row Headings

These headings are the lettered and numbered grey areas located just outside
the column and rows. Clicking on a heading will allow you to select the
entire row or column. You will also be able to change and modify, according
to your preference, the column width or row height while using the headings.



Workspace

The workspace feature allows you to simultaneously open numerous files just
like in the case of worksheets in a workbook.



Ribbon

Just above the workbook is a section of command tabs that is known as the
ribbon. An array of options are found behind each tab of the ribbon.



Cell Reference

The set of coordinates that classifies a specific cell is called a cell reference.
It is a combination of both numbers and letters. For example, A2 would point
to the cell that is situated where column A and row 2 intersect.



Cell Range

A cluster of cells that have been identified as a single group based on an array
of criteria is known as cell range. By using a colon between the cell
reference, Excel will determine the range, which is also called an array. A
range in a row could look like A2: D2, telling us that the formula is between
A2 and D2, while C5: F9 would tell the formula to look at the cells in a box
bounded by column C and F, and rows 4 and 9. A 3-D reference means a
range that contains more than one worksheet in the same workbook.



Merged Cell

When two or more cells are joined together, it is known as a merged cell.



Template

A template is a well formatted workbook or a worksheet intended to help its
users to fulfill a very specific need in Excel. Some examples of this include
calendar, stock analysis, and process map.



Formula

A formula is a sequence inside of a cell that is used to obtain a certain value.
The formula must begin with an equality sign (=), and it could be anything
from a mathematical equation, to cell reference, functions, or operators. The
formula is also commonly known as an expression.



Formula Bar

Located between the workbook and ribbon, the Formula bar displays the
contents of an active cell. If a formula is used, the formula bar will display all
the components of the formula.



Operator

Signs or symbols that specify which calculation has to be made in a particular
expression are known as the operators. They are not limited to simple
mathematical types; text, reference, comparison, or concatenation can also

exist.



Function

There are certain formulas that are pre-built into Excel for ease of use, and
these formulas are known as Functions. The main purpose is to simplify
extremely complex formulas in a worksheet, so that one can work at their
convenience.



Error Code

If Excel finds an error or problem with a provided formula, an Error Code
will appear.



Cell Formatting

Cell formatting is the act of changing how a cell or the contents of the cell are
shown or displayed in the spreadsheet. While formatting a cell, only the
visual appearances of the cells are changed, and the values within the cells
will remain unchanged.



AutoFill

This feature enables the users to be able to copy the data to more than one
cell very easily.



AutoSum

The numbers that have been entered in various cells can be added up using
this particular feature. It will display the total of the selected cells in a cell of
your choice.



Filter

The guidelines that can be employed to choose which rows in the worksheet
you are working on you want displayed, while hiding all others, are known as
Filters. These filters can use data such as values or conditions.



AutoFormat

This is a feature that enables you to apply predetermined conditions to the
cell, which could be as simple as the size.



Pivot Table

This tool is commonly used to sort, sum up, or average the data
automatically. The information is taken from one table, while the results are
presented in another.



Pivot Chart

This is the type of chart that provides a visual aid for pivot tables by
providing some graphical illustrations of the data from the pivot table.



Pivot Area

The pivot area is a point on the spreadsheet where you want to drag a pivot
table field in order to rearrange how a particular report is displayed.



Source Data

Source data is the information used to create your own pivot table. It exists
within the spreadsheet or can be taken from an external database as well.



Values Area

In a particular pivot table, value areas can be recognized as the cells that
contain the instantaneous information that is useful to the user.



Item

Items are sub-categories of fields in the pivot table. For example, if you have
an area that is marked Country, the items could be the United States, Canada,
India, etc.

These are the various terminologies used in Excel that can easily explain the
different uses of Excel as well. Once you understand the terminology, it will
become easier to understand the different tabs of Excel and their uses, which
are explained in the next chapter.



Chapter 5: Understanding the Different Tabs in
Excel

Here are the Excel 2020 tabs explained in detail.



Home Tab

The home tab has the most commonly used commands in Excel. The
commands that fall under the home tab include clipboard, font, alignment,
styles, editing, and so on. The various tabs are explained briefly below.



Clipboard

You can show the Clipboard Task Pane by clicking on the dialog launcher in
the lower right corner of the Home tab.
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e C(Cut - It cuts the current selection and keeps it in the clipboard. (Ctrl +
X)

e Copy - Copies the current selection to the clipboard, which can later be
pasted. The drop-down menu has the command Copy as Picture as
well. (Ctrl + C)

e Paste - This particular button will paste the current contents from the
clipboard to where you want them. The drop-down menu contains the
following commands: Formulas, Paste, Paste Values, Use Text Import
Wizard, Paste Link, No Borders, Transpose Refreshable Web Query,
Paste as Hyperlink, and Paste Special. The As Picture extension
contains: Copy as Picture, Paste Picture Link, and Paste as Picture.
Exactly which commands are enabled will be determined by the type of
the object that has been copied.

e Format Painter - This function copies the format from a cell (or range of
cells), allowing it to be pasted somewhere else.



Font

The Format Cells dialog box and Font tab can be displayed by clicking on the
dialog box launcher in the lower right corner of the Home tab. This particular
section is used to format the size and type of your fonts. The options under
this tab include font size, font type, increase and decrease font, bold,
underline, and italic.
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e Font Type - There is a drop down menu which provides a list of all the
available font styles which you can easily choose from.

e Font Size - The drop-down menu lets you adjust the character size of
your text.

e Increase Font Size - This allows you to increase the font size of the
current selection to the next largest size in the Font Size box.

® Decrease Font Size - This will decrease the font size of the current
selection to the next smaller size in the Font Size box.

e Bold - This permits you to make the current selection bold. (Ctrl + B)

e Underline - This button adds a line under the present selection. The
drop-down contains the following commands: Underline and Double
Underline.

e Borders - This button has a drop-down menu. The button applies a
border to the current selection. The drop-down contains the following



commands: Bottom, Right, Top, Left, No, Outside, All, Bottom
Double, Thick Box, Thick Bottom, Top and Bottom, Top and Double
Bottom, Top and Thick Bottom, Draw Border Grid, Draw Border, Line
Color, Erase Border, Line Style and More Borders. (Ctrl + U)

e Italic - Toggles italics on the current selection. (Ctrl + I)

Fill Color - This is a button with a drop-down menu. The button fills a
color to the contextual of the present selection. The drop-down contains
these commands: Standard Colors, Theme Colors, More Colors, and
No Fill.

Font Color - This is a button with a drop-down menu. The button
changes the color of the currently selected font. The drop-down
contains the following commands: Automatic, Standard Colors, Theme
Colors, and More Colors.



Alignment
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You can show the Format Cells dialog box Alignment tab by clicking on the
dialog box launcher in the bottom-right corner of the home tab.

Top Align - Aligns the text to the top of the cell.
Middle Align - Aligns the text to the middle of the cell.
Bottom Align - Aligns the text to the bottom of the cell.

Orientation - A drop-down menu will appear. It rotates the present
selection to a vertical or a diagonal angle. The drop-down contains
these commands: Angle Counter-clockwise, Angle Clockwise, Vertical
Text, Rotate Text Down, Rotate Text Up, and Format Cell Alignment.

Wrap Text - This wraps the text so that it is displayed on multiple lines
so you can see all of it.

Align Left - This aligns data to the left side of the cell.
Center - This aligns data to the middle of the cell.
Align Right - This aligns data to the right side of the cell.

Merge & Center - This is a drop-down menu. The button merges the
selected cells and centralizes the material in the new cell. The drop-
down menu contains the following commands: Merge & Center, Merge
Cells, Merge Across, and Unmerge Cells. Merge Across merges the
cells in the same row.

Decrease Indent - Decreases the indent by a level of 1 or removes the



indent completely. (Ctrl + Alt + Shift + Tab)

e Increase Indent - Increases the indent by a level of 1. (Ctrl + Alt + Tab)
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You can display the Format Cells dialog box, Number tab, by clicking on the
dialog box launcher in the lower right corner of the home tab.

e Number Format - This command provides a list of all the available
number formats. The built-in number formats are as follows: General,
Currency, Number, Accounting, Long Date, Short Date, Time,
Fraction, Percentage, Scientific, and Text.

e Accounting Number Format - This is a button with Drop-Down menu.
The button adds your default accounting number format to the current
selection. The drop-down contains the following commands: English
(US), English (UK), Euro and More Accounting Formats.

e Percent Style - This applies the percent number format to your present
selection. (Ctrl + Shift + %)

e Comma Style - It will apply the comma style number format to your
present selection.

e Increase Decimal - It will add one decimal placement to the current
selection.

e Decrease Decimal - It will take away one decimal placement from the
current selection.



Styles

Conditional Formatas Cell
Formatting~ Table~ Styles~

Styles

e Format as Table - This drop-down applies a Table Style to your current
selection and defines it as a table. The drop-down is made up of these
commands: Light, Dark, Medium, New Table Style and New
PivotTable Style. The New Table Style shows the New Table Style
dialog box. The New PivotTable Style shows the New PivotTable Style
dialog box.

e (Conditional Formatting - This is a drop-down menu. It gives access to
the conditional formatting commands which can be used to apply cell
formatting automatically. It contains these following commands:
Highlight Cells Rules, Top/Bottom Rules, Color Scales, Data
Bars,Clear Rules, Icon Sets, New Rule and Manage Rules.

e Cell Styles - This is a drop-down menu. This applies a specified cell
style to your present selection. The drop-down is made up of the
following commands: Custom, Good, Bad and Neutral, Data and
Model, Titles and Headings, Number Format, Themed Cell Styles, New
Cell Style and Merge Styles.



Cells
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Cells

Delete - This is a button with a drop-down menu. The delete button

always deletes the present selection therefore shifting cells up. The
drop-down menu contains the following commands: Delete Cells,
Delete Sheet Columns, Delete Sheet Rows and Delete Sheet.

Insert - This is a button with a drop-down. The button is used to insert
cells into the current selection, thereby shifting cells down. The drop-
down contains the commands: Insert Cells, Insert Sheet Columns,
Insert Sheet Rows, and Insert Sheet.

Format - It is a button with a drop-down menu. The format option
provides a lot of useful commands that apply to columns, rows, and
sheets. The drop-down contains the below mentioned commands:
Column Width, AutoFit Column Width, Row Height, AutoFit Row
Height, Default Width, Hide & Unhide, Rename Sheet, Move or Copy
Sheet, Protect Sheet, Tab Color, Lock Cell and Format Cells. The Hide
& Unhide extension comprises the commands: Hide Rows, Unhide
Rows, Hide Columns, Unhide Columns, Hide Sheet, and Unhide Sheet.



Editing
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° AutoSum - This is a button with a drop-down menu. The same

command can be found on the Formulas Tab and it contains the
following commands: Sum, Average, Count Numbers, Max, Min.



More Functions

e Fill - This is a drop-down menu. This option lets you fill the selection in
any direction and also into any range of adjacent cells. The drop-down
menu contains the following commands: Down, Up, Right, Left,
Across Worksheets, Justify, Series, and Flash Fill.

e Sort & Filter - This is a drop-down menu. This helps you sort the
currently selected data or current region into descending or ascending
order and allows you to add filters to decrease the number of evident
rOws.

e C(lear - This is a drop-down menu. Clear removes everything from the
current selection or removes particular items. The drop-down contains
these mentioned commands: Clear All, Clear Contents, Clear Formats,
Clear Hyperlinks, Clear Comments, and Remove Hyperlinks.

e Find & Select - This is a drop-down menu option. This option permits
you to find and replace an input or selected data. The drop-down
contains the following commands: Find, Replace, GoTo, GoTo Special,
Comments, Formulas, Constants, Conditional Formatting, Select
Objects, Data Validation, and Selection Pane.



Insert Tab

The insert tab permits the insertion of various inputs into your Excel
worksheet. Below are the insert options:
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Tables

PivotTable - This feature displays the Create PivotTable dialog box. It
is used to arrange and summarize complex data inside a PivotTable.
The drop-down menu contained the commands: PivotTable and
PivotChart. The PivotTable shows the Create PivotTable dialog box
and the PivotChart shows the Create PivotTable and PivotChart dialog
box.

Recommended PivotTables - This shows the Recommended
PivotTables dialog box. It displays a list of customized pivot tables that
are good for your data.

Table - This displays the Create Table dialog box. When you outline
your data as a table, it will make it easier to filter, sort and apply
formatting. (Ctrl + T)



Illustrations
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llustrations

e Pictures - This displays the Insert Picture dialog box, permitting you to
browse to a file from your file system.

e Online Pictures - Discover and insert pictures from an assortment of
online sources.

e Shapes - This is a drop-down. The drop-down contains the commands:
Recently Used Shapes, Rectangles, Lines, Basic Shapes, Equation
Shapes, Flowchart, Block Arrows, Stars and Banners and Callouts.

e Icons - This displays the Insert Icons dialog box. You can insert an icon
to visually communicate what you are explaining by using symbols.

e 3D Models - This displays a drop-down menu. It allows you to insert a
3D model so you can rotate it and view it from various angles. The
drop-down contains the following commands: From a File and From
Online Sources.

e  SmartArt - This shows the Choose a SmartArt Graphic dialog box,
which allows you to choose from a SmartArt series: List, Cycle,
Process, Hierarchy, Matrix, Relationship, Pyramid, Picture and
Office.com.

e C(lip Art - This shows the Clip Art task pane to let you insert drawings,
sounds, movies, photos and so on.

e Screenshot - This is a drop-down. It allows you to insert a snapshot



from your Windows. The drop-down contains the commands:
Available Windows and Screen Clipping.



Charts
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e Column or Bar - This is a drop-down. It is used to visually compare
values across a few categories. The drop-down is made up of these
commands: 2-D Column, 3-D Column, 2-D Bar, 3-D Bar and More
Column Charts.

° Recommended Charts - This is used to insert charts that are
recommended for the chosen data. Excel will identify your data type
and give you many recommendations for the suitable charts.

e Line or Area - This is a drop-down menu. It is used to show trends over
time such as year, day, month, etc. The drop-down contains the
following commands: 2-D Line, 3-D Line, 2-D Area, 3-D Area, and
More Line Charts.

e  Pie or Doughnut - This is a drop-down menu. It is used to show
proportion of a whole. The drop-down contains the following
commands: 2-D Pie, 3-D Pie, Doughnut and More Pie Charts.

e Hierarchy - This is a drop-down. It is used to compare parts to a whole.
The drop-down contains the commands: Treemap, Sunburst and More
Hierarchy Charts.

e  Statistic - This is a drop-down. It is used to statistically analyze your
data. The drop-down contains the commands: Histogram, Box and
Whisker and More Statistical Charts.

e Scatter XY or Bubble - This is a drop-down menu. It is used to show
relationships between sets of values. The drop-down contains these
commands: Scatter, Bubble and More Scatter Charts.



Waterfall or Stock - This drop-down contains the following commands:
Waterfall, Funnel, Stock, Surface, Radar and More Stock Charts.

Combo - This is used when the range of values varies or when you have
mixed data. The drop-down contains the commands: Combo and Create
Custom Combo Chart.

Maps - This is a drop-down. The drop-down contains the commands:
Filled Map and More Map Options.

PivotChart - This is a button with drop-down. You can insert this to
graphically summarize and explore complicated data. The button
displays the Create PivotChart dialog box. The drop-down contains the
following commands: PivotChart, and PivotChart & PivotTable.

Other Charts - This is a drop-down that offers access to other chart
types. The drop-down contains the commands: Stock, Doughnut,
Surface, Radar, Bubble, and All Chart Types.



Tours

3D Map - This is a button with a drop-down menu. It is used to set
graphical data on a 3D map. It permits you to create data visualizations
in your workbooks. The button displays the Power Maps for Excel
window. The drop-down is made up of these commands: Launch Power
Map and Add Selected Data to PowerMap. You must enable the Data
Analysis add-ins to use this 3D map feature



Sparklines

e Line - Displays the Create Sparklines dialog box which lets you insert a

line chart within a single cell representing a row of data in your
selection.

e Column - Displays the Create Sparklines dialog box which lets you
insert a column chart in a single cell.

e Win/Loss - Displays the Create Sparklines dialog box which permits
you to insert a win/loss chart in a single cell.



Filter
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Filters

e Slicer - The slicer visually filters data in your Tables.

e Timeline - This filter dates your tables, pivot charts, and pivot tables.



Links

e Link - Button with drop-down. Displays the Insert Hyperlink dialog
box. It is used to create links in your document for quick access to the
webpage. (Ctrl + K)



Text

e Text Box - Inserts a textbox that can be situated anywhere on the page.

Header & Footer - This automatically positions your cursor in the
header box. This will then show the Header & Footer Tools - Design
contextual tab.

e WordArt - This is a drop-down menu. It gives you a choice of Word Art
styles that you can insert. The drop-down has a gallery of various
styles.

e Signature Line - This is a button with a drop-down menu. This button
inserts a signature line that stipulates the individual must sign. The
drop-down shows these commands: Microsoft Office Signature Line,
and Add Signature Services.

e Object - This displays the Object dialog box permitting you to insert
entrenched objects.



Symbols

This gives you the ability to insert symbols that are not on your system
keyboard.

e FEquation - This is a drop-down menu. From here, you can insert the
equation you desire to your workbook. The drop-down contains the
following commands: Area of Circle, Expansion of a Sum, Binomial
Theorem, Fourier Series and Insert New Equation.



Page Layout Tab

Aaj B colors ~
S Fonts ~
Themes -

- Effects ~

Themes



Page Setup

The page setup gives you access to alter the settings of your workspace. Here,
you can change the orientation, margin, background, page size, etc.
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Margins - This is a drop-down menu. It permits you to choose from one
of your built-in margin settings and also lets you customize your own.
The drop-down menu contains these commands: Normal, Narrow,
Wide, and Custom Margins.

Orientation - This has a drop-down menu. This allows you to switch
between Landscape and Portrait layout.

Size - This has a drop-down menu. It allows you to select from all the
different available paper sizes for your document. More Paper Sizes
displays the Page Setup dialog box, Page tab.

Print Area - This has a drop-down menu. This permits you to choose the
area on the sheet that you would like to print. The drop-down contains
the following commands: Set Print Area and Clear Print Area.

Breaks - This is a drop-down menu. This menu contains the following
commands: Insert Page Break, Remove Page Break and Reset All Page
Breaks.

Background - This feature allows you to add background images to the
worksheet. This caption changes to Delete Background if an image is
allotted to the worksheet you are currently working on.

Print Titles - This displays the Page Setup dialog box, Sheet tab. This
permits you to enter rows or columns to repeat on each printed page.



Scale to Fit
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e Width — This shrinks the width of the printout to fit a certain number of
pages. The combo box consists of Automatic, 1 to 9 pages, and More
Pages. More Pages displays the Page Setup dialog box, Page tab.

e Height - This shrinks the height of the printout to fit a certain number of
pages. The combo box contains Automatic, 1 to 9 pages and More
Pages. More Pages displays the Page Setup dialog box, Page tab.

e Scale - This shrinks or stretches the printout to a percentage of its real

size. It changes the page scale in increments of 5 percent. It also
provides a shortcut to the Page Setup.



Sheet Options
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e  Gridlines View - This toggles the display of gridlines on the active
worksheet.

e Gridlines Print - This toggles whether the gridlines are printed.
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e Headings View - This toggles the displays of row numbers and column
headers on the active worksheet.

e Headings Print - This toggles whether the row and column headers are
printed.



Formulas Tab

e Insert Function - This is a drop-down menu. With this, you can insert a
function (a formula) in your current cell. It displays the Insert Function
dialog box, allowing you to search for a specific function or display the
list of functions by grouping. (Shift + F3).

e AutoSum - This is a button with a drop-down menu. This button inserts
the Sum formula into the cell calculating the total of the chosen cells
and placing the total below the selected cells. The drop-down contains
the following commands: Sum, Average, Max, Min, Count Numbers,
and More Functions.

e Financial - This has a drop-down menu. It provides quick access to all
the financial functions that you may want to add to your worksheet in
the Financial category.

e Logical - This has a drop-down menu. It provides quick access to all the
logical functions in the Logical category that you may want to add to
your worksheet.

e Text - This has a drop-down menu. It provides quick access to all the
text functions in the Text category that you may want to add to your
worksheet.

e Date & Time - This has a drop-down menu. It provides quick access to
all the date and time functions in the Date & Time category that you
may want to add to your worksheet.

e Lookup & Reference - This has a drop-down menu. It provides quick
access to all the lookup or reference functions in the Lookup &
Reference category that you may want to add to your worksheet.

e Math & Trig - This is a drop-down menu. It provides quick access to all
the Mathematics and Trigonometry functions in the Mathematics &
Trigonometry category that you can add to your worksheet.



e More Functions - This is a drop-down menu. It displays a drop-down
giving you access to more functions like the Statistical, Information,
Engineering, Compatibility, Cube, and Web categories.



Defined Names

Name Manager - This grants you access to find and modify all the
names used in the workbook.

Define Name - This is an option with a drop-down menu. The drop-
down contains the following commands: Define Names, and Apply
Names. Define Names lets you create a workbook and worksheet name
and displays the New Name dialog box.

Use in Formula - This is an option with a drop-down menu. This drop-
down menu contains a list of all the names used in the workbook so
you can paste them in the current formula.

Create from Selection - This automatically generates names from the
chosen cell. It allows you to name a selected range of cells using a
column or row title that you've entered.



Formula Auditing
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Farmula Auditing

e Trace Precedents - This shows arrows that specify what cells affect the
value of the currently chosen cell.

e Trace Dependents - This displays arrows that specify what cells are
affected by the value in the currently selected cell.

e Remove Arrows - This is a drop-down menu. This button gets rid of all
the arrows drawn by the trace dependents and trace precedents. The
drop-down contains these commands: Remove Arrows, Remove
Dependent Arrows, and Remove Precedent Arrows.

e Show Formulas - This is a display of the formulas in each cell rather
than the result. (Ctrl + ).

e Error Checking - This checks for common errors that occur when using
formulas. The drop-down contains these commands: Error Checking,
Trace Error, and Circular Reference. The Circular reference extension
is only active when the current workbook comprises at least one
circular reference.

e Evaluate Formula - This assists you in debugging a complex formula so
as to evaluate each part of the formula individually; in other words, it
allows you to step through a formula calculation so as to verify its
correctness.

e  Watch Window - This lets you view the contents of cells and their
results as you update different parts of the worksheet.



Calculation
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Calculation
e (alculation Options - This drop-down menu lets you easily alter the

calculation setting in the active workbook between Automatic and
Manual.



Data Tables

° Calculate Now - This provides a shortcut to calculate the entire
workbook now. (F9)

° Calculate Sheet - This provides a shortcut to calculate the active
worksheet. (Shift + F9).



Data Tab
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e Get Data - This helps you discover, connect, and combine data from
various sources. The drop-down menu includes the following
commands: From File, From Azure, From Database, From Other
Sources, From Online Services, Launch Query Editor, Data Combine

Queries, Query Options, and Source Settings.

e From Text/CSV - This imports data from a text, comma-separated
value, or a formatted text file.

e From Web - This imports data from a web page.

e From Table/Range - This feature permits you to create a new query
linked to the selected table. If the selected range is not part of a table, it
will be transformed into a table.

e Recent Sources - This manages and connects to recent sources of data.

e Existing Connections - This imports data from common sources.



Sort & Filter
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Sort & Filter

e Sort A to Z - It sorts data from lowest to highest, alphabetically from A-
Z and numerically from the lowest number to the highest number.

e Sort Z to A - It sorts data from highest to lowest, alphabetically from Z-
A and numerically from the highest number to the lowest number.

e Sort - This allows you to find values quickly by sorting your data.
e Filter - This toggles filtering on the currently selected cell.

e Clear - It clears the filter and sort for the currently selected range of
data.

e Reapply - This helps you to reapply the filter and sort to the current
selection so that the changes you have made are included. (Ctrl + Alt +
L)



Data Tools
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e Text to Columns - This permits you to split a single column of text into
multiple columns.

e Remove Duplicates - This removes duplicates sheets from a row.

e  Flash Fill - This automatically fills in values into the cell of your
choice.

e Data Validation - This drop-down lets you limit the type of data that
can be entered into a cell. The drop-down includes the following
commands: Circle Invalid Data, and Clear.



Validation Circles

Relationships - This relationship feature lets you create or modify
relationships between tables to show the linked data from separate
tables on the same report.

Consolidate - This summarizes the data from separate ranges then
consolidates the result in a single output range.

Manage Data Model - This opens the Power Pivot window in order to
add and prepare data or continue working on data on the current
workbook.



Review Tab

Spelling Thesaurus Workbook
Statistics

Proofing



Proofing

e Spelling - This spelling feature lets you check the spelling on the active
worksheet. (F7)

e Research - This toggles the display of the Research Task Pane.

e Thesaurus - You can research another way of saying what you mean by
using the Thesaurus feature.



Language

e Translate - This translates the selected text into a different language.



Comments
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Comments

New Comment / Edit Comment - This inserts a comment at the
currently active cell. (Shift + F2)

Delete - This deletes the selected comment in a cell.

Previous Comment - This shifts you to the previous comment in the
currently active workbook.

Next Comment - This moves you to the next comment in the currently
active workbook.

Show Comments - This toggles the display of the Comments task pane
to be shown.

Notes - The drop-down menu contains the following commands: New
Note, Next Note, Previous Note, Show All Notes, Show/Hide Note, and
Convert to Comments.



Protect
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Protect

e Protect Sheet — You can prevent unwanted alteration from third parties
and limit their ability to edit your worksheet.

e Protect Workbook — This helps you to protect your shared workbook
from others so they don’t make structural changes to your workbook.

e Allow Edit Ranges — This feature allows specific users to modify
certain ranges in a workbook or sheet. You can set up a password
protection on your workbook ranges as well.

e Unshare Workbook - This is deactivated by default. If you open a
workbook that is currently being shared using the “Share Workbook”
option, this feature will become activated, letting you unshare the
desired workbook. Shared workbooks have been replaced with Co-
Authoring in the 2020 version.



View Tab

The commands for hiding and viewing workbooks as well as windows can be
found on this tab.



Workbook Views
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Workbook Views

e Normal — This allows you to view the worksheet in the normal view.
There is also a shortcut to this view in the bottommost right corner of
the status bar on your page.

e Page Break Preview - Used for adjusting page breaks whereby you can
see where the page break will appear when the document is printed.
There is also a shortcut to this view in the bottom right corner of the
status bar.

e Page Layout — This displays the worksheet as it will appear on a printed
page. It displays a horizontal and vertical ruler; you can add/change
headers and footers, row/column headings and scaling selections, and
check margins as well.

e (Custom Views — This allows you to save your current display settings
for future use.

e Full Screen — This shows the workbook in full screen mode. You can
press Esc to return to the normal screen mode.



Show

Formula Bar
Gridlines Headings
g

Show

e Formula Bar - This toggles the display of the formula bar so that you
can see the formula in a cell.

e Gridlines — This displays the line between the columns and rows in the
worksheet in order to make the sheet easier to read.

e Headings - This toggles the display of the column heading and row
numbers.

e Message Bar — This displays the message bar which shows any required
actions that are to be completed.



Z.oom

Q (3 &

Zoom 100% Zoom to
Selection

Zoom

e Zoom — This allows you to zoom your worksheet to the level that you
desire.

e 100% - You can zoom your workbook to 100% of its standard size.

e Zoom to Selection -You can zoom the worksheet to display just the
currently selected cells in the whole window.



Chapter 6: Formatting of Cells and Other Basics

This chapter teaches us the basics of formatting a cell in a workbook. The
steps are easy to understand and explain the font style, size, color, and more
that can be formatted using the provided tools.



Formatting Font Style

You can change your font style by selecting (highlighting) the data and
clicking on the font pane to select the style you wish to use for the data you
want to input. Excel 2020 comes with a lot of good-looking fonts, varying
from Calibri, to Arial, Verdana and so on.

Calibri (11 .




Formatting Your Font Size

The font size of your data determines how big or small it will look on your
sheet. Depending on the type of document you are working on, you will have
to select your font size with respect to your desired output size. This means a
larger font size will give bold and big looking data. To alter your data font
size, first highlight the data you wish to change then navigate to the font size
pane at the top left side of the worksheet and toggle the font sizes to that of
your choice.

*111 = Aﬁ
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You can also either decrease or increase your font size by clicking on the
alphabet ‘A’ that is situated just beside the font size pane. If you click the
bigger ‘A’, it will increase your font size and if you click the smaller ‘A’ , it
will decrease the font size.




Formatting with Bold, Italics and Underline

B I U -

To add either bold, italics, or underline, or a combination of any of them, first
select (highlight) the data you wish to format, then navigate to the font pane
under home tab and select your desired format option. If you wish to apply
the bold format, click on the ‘B’ icon, if you wish to apply the underline
format, click the ‘U’ icon. If you wish to apply the italics format, click the ‘T’
icon. If you wish to apply more than one of these format options, just click
the combination that you want to use.

For the underline option, you can choose to use single or double underline
format. To choose either of these, click the drop-down icon by the underline
icon to show the drop-down menu for selection of various choices.



Formatting Your Font Color

You can select to use a different color for specific data. To change your data
color, click the colored pane under the font tab. This will show a drop-down
menu of color options, which you can choose from as per your choice.
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Formatting the Bottom Border

There are times when you will need to use a bottom border to differentiate
some data from the rest, such as when writing a header for a set of data. To
add borders to your data, click the border button at the font pane and select
your border type. When clicked, numerous border styles will load, ranging
from bottom, top, left, right, thick outside border, and so on. Depending on
your desired output, you will have to look at the illustration of each of these
border options and choose the one that best fits your desired output.
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Formatting Number Type

There are times when you will be dealing with a specific number type such as
currency. For example, if you are dealing with currency, different countries
have different currency units and symbols. To insert a currency symbol into
your data, navigate to the number pane under the home tab, select the
currency symbol you are dealing in, and it will be displayed.

Just in case the displayed currency type is not the currency you are dealing in,
you can click the drop-down link beside the dollar symbol to load other
currency types. One thing you will observe after choosing a currency type for
your data is that decimal places will be input into your data.

You can choose to either increase or decrease the decimal place. To do this,
click the zeros button beside the currency type. There are two buttons here;
one is to increase the decimal places, while the other is to decrease the
decimal places.
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Formatting an Overlap Data

Cells in Excel are designed with equal cell size by default. There are times
when you will enter the data into a cell and it will overlap into the following
cell. An example is shown below.

D E | °F

Ibdustrializatinn

In the sample above, the data was entered into column D but as observed, the
data has exceeded column D and has overlapped into columns E and F. To
correct this, navigate to the top of the original cell column (column D in this
instance) and click the column. You will see that the column will be
highlighted.

Once this happens, position your cursor at the extreme right edge of the
column, and then you will observe that the cursor will change to arrow-cross.
You can now click and drag the column edge until your data fits in.

Another easier way you can do this is by highlighting the overlapped data
cell, navigating to the format pane at the top-right side, and selecting autofit
column width (provided it overlaps by the width) or autofit column height
(provided it overlaps by the height).



Repeating a Format Using the Format Painter

There are times when you might have performed a lot of formatting to
particular data and you want to repeat the same formatting for different data
entirely. Instead of going through the whole process and steps that you did on
the first data, you can make use of the format painter to repeat the exact same
formatting. To do this, select or highlight the formatted data, then double
click the format painter button on the top-right side of the worksheet.

Once you double click it, the previous formatting will be activated and ready
to apply to any other part or data on the same worksheet. To apply the
activated format, just click the cell containing the data you wish to apply the
format to; immediately all the formatting will be activated to it.
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Formatting Data into Table

There are times when you will have a range of data which you would like to
format into a table. To do this, select the range of data you wish to format
into a table. Now navigate to Format as a Table in the style pane in the home
tab. A drop-down will show different table formats; choose the one that best
suits your data.

Once you select the table format, immediately a pop up will show up
requesting your confirmation of the cell involved. Click ok to proceed, then
your data will be transformed into a table form.



Rotating Text Directions

There are times when text directions need to be rotated to a specific angle.
This is applicable mostly in tables, though it can also be done on pure data.
To achieve this, select the cell containing the text you wish to rotate. After
that, navigate to the alignment pane under the home tab and click on the
arrow at the bottom right of the alignment pane to load more alignment
options.

Once you click that button, the alignment extension will be loaded and you
can now select the angle of your text rotation.

You can also choose to enter the rotation angle in the box.
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Inserting a New Row and Column into Your Table

You may want to insert a new row, column, or both into your table. To insert
a new column, select the column where you wish to have the new column
inserted and navigate to the cells pane in the home tab and click insert. Once
clicked, a drop-down menu will show asking if you want to add a new
column or a new row.
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Select the insert sheet column and automatically, the column will be added.

The same procedure goes for the row; if you wish to add a new row, follow
these steps to get it done.

An easier and faster means of inserting rows and columns is by clicking the
row or column where you wish to add a new one, then right-click and select
insert. This will automatically insert a new row/column depending on your
selection area.



Deleting a Cell
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Insert Delete Format
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To delete a cell is simple: first select the cell/row/column as the case may be
and navigate to the cell pane at the top-right side of the pane, then click
delete. You will be asked if you are deleting a sheet row, a sheet column, or a
cell; choose the corresponding option.

A shorter and faster means of getting this done is by selecting the cell, row,
column you wish to delete, then right-click your mouse and select delete.



Hiding and Unhiding Data

You can hide data as well as unhide data in Excel. To hide a range of data,
highlight the cells with the data and right click on them, then select hide.

To unhide the data, just repeat the same procedure and select unhide. The
data will become visible again.



Chapter 7: Explanation of Excel Formulas

As we know, when learning the basics of Excel, we also need to learn what
actually makes it easier to use: the formulas. It is important that we
understand each formula and how to use them in order to take full advantage
of the features of Excel. This chapter attempts to explain formulas in great
detail.



The SUM Function

The SUM function allows you to add or sum up the values of the selected
rows or columns: =SUM (number1, [number2], and so on)

To insert the SUM function, follow these steps:
1. In the cell, type the SUM function.
2. Go to the Function argument to select the cells into the cell range box
3. Click on Enter.



The AVERAGE Function

The AVERAGE function is used to determine and calculate the average of a

group of numbers and it is written almost the same way as the SUM function:
=AVERAGE (number1, [number2], and so on)

Follow these steps to insert the AVERAGE function:

1. In the cell, type the AVERAGE function

2. Go to the Function argument to select the cells into the cell range box
3. Click on Enter.



The MAX Functions

The MAX function is used to locate the cell with the highest value: MAX E
(numberl, [number2], ...)

To insert the MAX function follow these steps:

1. In the cell, type the MAX function
2. Go to the Function argument to select the cells into the cell range box
3. Click on Enter.



The MIN Function

The MIN function is used to locate the cell with the lowest value: MIN
(numberl, [number2], ...)

The following steps insert the MIN function:

1. In the cell, type the MIN function
2. Go to the Function argument to select the cells into the cell range box
3. Click on Enter.



The TEXTJOIN Function

The TEXTJOIN function combines or joins texts from different ranges with a
given delimiter to differentiate between each text or value that will be joined
or combined: TEXTJOIN (delimiter, ignore empty, textl, [text2], ...)

To insert the TEXTJOIN function, use the following steps:

1. In the cell, type the TEXTJOIN function
2. Go to the Function argument to select the cells into the cell range box
3. Click on Enter.



The LEN Function

Len function, also known as the ‘length excel function’, is a function that is
used to count the number of characters in the form of letters, numbers, special
characters, and all spaces from a particular Excel cell.

The steps to insert the LEN function are:

1. In the cell, type the LEN function with the cell reference
2. Click on Enter.



The COUNT Function

The COUNT function helps to count the number of cells that contain
numbers as well as count numbers within the list of arguments: COUNT
(valuel, [value2], ...)

To insert the COUNT function:

1. In the cell, type the COUNT function
2. Click on Enter.



The TRIM function

The Trim function removes all the spaces between words except for the
single spaces. The trim function can also remove irregular spacing from text
copied from other applications.

The steps to insert the TRIM function are as follows:

1. In the cell, type the TRIM function with the cell reference.
2. Click on Enter.



The XLOOKUP Function

The Excel XLOOKUP function is a replacement for functions like
VLOOKUP, HLOOKUP, and LOOKUP. It allows you to search for an item
and gives the best matching result: XLOOKUP

When using the XLOOKUP, you must be able to provide three parameters:

1. The value you are looking for (‘Look up value’).
2. The list where the value can be found (‘Look up array’).
3. The list from which you want the result (‘Return array’).



The SORT Function

The Sort function helps to sort the contents of a column in ascending or
descending order: =SORT (array, [sort index], [short-order], [by col])

1.
2.
3.

Type in the SORT function in the cell

Choose the entire table

Select the Sort index which can be column 1 or 2 depending on your
choice, then select the Sort order which can be in ascending order for -1
or descending order for 1.

In the final option, you can choose True or False depending on how
you want your column or row. Finally, the data is sorted out as you
desired.



The UNIQUE function

The Unique function helps to extract or return a list of distinctive values or a
list of values that appear only once: =UNIQUE (array, [by_col], exactly
once])

To use the UNIQUE function:

1. Type in the UNIQUE function in the cell
2. Select the entire cell.

On the selected cell it will return the unique values on the list.

To show the value that appears once on the list, go to the formula bar and edit
the UNIQUE function by changing to TRUE, which will return every item
that appears once. Then, the value that appears once will be displayed.



Chapter 8: Inserting Charts

Working With Charts

Charts in Excel help to present data on your worksheet in a visual form,
displaying the data which are in the form of rows and columns as bars on a
chart. There are a variety of charts that can be applied or used to display data.
Excel provides charts like Pie chart, Bar chart, Line chart, Column chart, and
more.

Data shown in charts is more interesting, clearer, and easier to read and
understand. With the use of charts, you can evaluate your data and make
comparisons between different values.

How to Insert a Chart in Excel

First, select the data you want for the chart. Then select Insert and go to
Recommended Charts. There, you can choose a chart on the Recommended
charts tab and preview the chart.

Select the chart and click on the OK button.

How to Add a Title to a Chart

When you add a title to your chart, it gives your chart a sense of purpose, and
people going through your work on the Excel sheet will be able to recognize
the purpose of the chart. To add a title to your chart, all you need is to do is
click anywhere within the chart area, then click on the plus sign at the upper
part of the chart. Click on Chart title among the options listed. To change it
from ‘Chart Title’, just click into the textbox to type any title of your choice.

PLEASE NOTE: To change the color, font size, and the font type, just right-



click on the title.

How to Change Chart type in Excel

There are different types of charts used in the presentation of data. If the chart
type you used in presenting your data is not suitable or appropriate, you can
switch to another chart that best explains your data.

To do this, click on the chart you wish to modify and then go to the Design
tab and select Change Chart Type. From Change Chart Type, a pop-up
window will be displayed where you will have to choose your charts from
Recommended charts or All charts options. Choose any chart you want and
then preview it. Next, click on OK, and the chart will be shown in the
worksheet.

How to Change Chart Style in Excel

To change the chart style in your Excel worksheet, click on the chart you
wish to modify. Go to the Design tab and select Change Chart Style.

How to Change Chart Layout in Excel

Click on the chart you wish to modify, go to the Design tab, and select Quick
Layout. Select the Chart layout you want, and the changes will be made to
the chart.

How to Switch Rows and Columns of Data in a Chart

You can change the way charts arrange your rows and columns of your data
to suit your interest. To do this, first click on the chart you wish to modify,
then go to the Design tab and select Switch Row/Column. The rows and
columns of the data will be switched.



How to Move a Chart

You can move a chart from any location on a worksheet or to a new or
existing worksheet.

To move a chart within a worksheet, with the mouse, you need to drag it to
the location you want it at.

To move it to another worksheet, click on the chart you wish to modify. Go
to the Design tab and select Move Chart Location. After clicking on Move
Chart Location, a window will pop up where you will need to choose where
you want the chart to be placed. Then click on the OK button and the chart
will be moved to another worksheet.

How to Resize a Chart on Your Worksheet

You can adjust the size of a chart to either small or big depending on what
you want. To carry out this operation, click on the chart to modify. At the
edges of the chart, some loop handles will appear. The loop handles allow
you to alter the horizontal and vertical arrangement of the chart. Click on the
loop handles to increase or decrease the size of the chart.



Chapter 9: Shortcuts, Tips & Tricks

To further understand some shortcuts of Excel, each shortcut is explained
below with its keys on the keyboard written first, followed by what those
keys do.

e Arrows: To move from one cell to the next

e E5:Goto

e Ctrl + Home: Go to cell 1

e Home: To go to the beginning of a row

e Shift + Arrow: To select the adjacent cell

e Shift + Spacebar: To select an entire row

e Ctrl + Spacebar: To select an entire column

e Citrl + Shift + Home: To select all to the start of the sheet

e Ctrl + Shift + End: To select all to the last used cell of the sheet

e Citrl + Shift + Arrow: To select the end of the last used row/column
e Ctrl + Arrow: To select the last used cell in rows/columns

e PageUp: To move the screen up

e PageDown: To move the screen down

e Alt + PageUp: To move the screen to the left

e Alt + PageDown: To move the screen to the right

e Citrl + PageUp/Down: To move to the next or previous worksheet
e Citrl + Tab: To move to the next worksheet while on the spreadsheet
e F2: To edit cell

e Citrl + C: To copy

e C(Ctrl + V: To paste



Ctrl + X: To cut

Ctrl + D: To fill down

Ctrl + R: To fill right

Alt + E + S: Paste special

F3: To paste the name into a formula

F4: Toggle reference

Alt +Enter: To start another new line within the same cell
Shift + F2: To insert or edit a cell comment

Shift + F10: To display a shortcut menu

Ctrl + F3: To define the name of a cell

Ctrl + Shift + A: To insert argument names with parentheses for a
function after typing a function name in a formula

Alt+ 1+ R: To insert a row

Alt+1+ C: To insert a column

Ctrl + B: To bolden

Ctrl + I: For italics

Ctrl + Z: To undo

Ctrl + Y: To repeat the last action

Ctrl + A: To select all cells

Ctrl + 1: To display or bring up the format cell menu
Ctrl + Shift + !: For number formatting
Ctrl + Shift + %: For percent format
Ctrl + Shift + #:For date format

Alt + H: To increase decimal

Alt + H + 9: To decrease decimal

Alt + H + 6; To increase indent



Ctrl + N: New

Ctrl + O: To open

Ctrl + S: To save workbook

F12: Save As

Ctrl + P: Print

Ctrl + F2: To open the preview print window
Ctrl + Tab: To move to the next workbook
Ctrl + F4: To close a file

Alt + F4: To close all open Excel files



Paste Special Shortcuts

Ctrl + Alt + V+T: Paste Special formats
Ctrl + Alt + V+V: Paste Special values
Ctrl + Alt + V+F: Paste Special formulas
Ctrl + Alt + V+ C: Paste Special comments

Some tips and tricks for different functions of Excel are mentioned below.



Using Ideas

If you are looking for suggestions on how best to display your Excel data, use
Ideas as inspiration. To do this:

e C(lick anywhere on the table you desire
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e Go to the Home tab and choose Ideas
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e Ideas will pop up any graph that is suitable to display your data.

e Then click on the Insert option.
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Removing Blanks From a Worksheet

If you want to remove several empty cells in a set of data:

e Select or highlight the whole list of data.
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e (lick on the Go to Special option.
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e To delete, right-click on any of the empty cells and select the Delete
option.
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e In the Delete option, select Shift cell left and the blanks cell will be
deleted.
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Steps to Remove Duplicate Data from Excel
Workbook

If you have a list of data in Excel and you want to remove the duplicates, do
the following steps:

e Highlight the data.
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e From the Data tab, select Remove Duplicate.
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e Select the option you want and click on OK.
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Transposing on Your Excel Worksheet

Transposing allows you to switch the rows and columns on your table. To do
this:

e Highlight the table, right-click, and select copy.
A B = D

s

Paile Optiam

5
3
o = Y o TN e I 1 O e T -

Cednty

e Select the new location, right-click on it, and select Paste Special.
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e Select the Transpose option and click on OK.
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Adding Text to Columns

You can copy texts into your column from a different source by applying the
following instructions to your worksheet:

e (Copy the data into an Excel sheet.
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e Go to Data and select Text to column.

#s Data Review View Developer Help  Power Pivot

[_, '._illfmit.sﬁcunnmiuni @ [,‘[I:] . “ ?i {:':Eg

® I L .

Rafe = Socks  Geography (5 E.-.I- Gan Fifter ™ o 5

Al {5t Edfit Link: "Eﬁruum:e:t B
Queras & Conmeminn [ala Types Som & Fuler Dat3 Topls.

e Go to the pop-up window that comes up and select Comma, check

for the preview at the lower part of the pop-up window, and click
on Finish.
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e The change has been effected.



Inserting Screenshots in Your Excel Workbook

To insert images from other applications to an Excel worksheet:

e Go to the Insert tab and click on Screenshot.
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e From the Screenshot tab, select the image available.

e Here, the chosen image will be displayed on the Excel sheet.
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Inserting Multiples Rows

Rather than inserting rows one by one in your worksheet, you can insert three
to four rows at once. This helps to save time. To add multiple rows:

e Highlight as many rows as you want and right-click on them.
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e C(lick on insert, and new rows will be added to your sheet.
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PLEASE NOTE: The steps above can be applied when adding multiple
columns in a sheet.



Creating People Graphs

A People Graph is a kind of graph that is created with a simple two-column
table. To create one:

e Go to the Insert tab and click on Transform data into a cool picture,
which will bring up a default people graph
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e When the default graph appears, move to select your data.

e Go to the simple two-column table to highlight your data and click
on Create.

e The changes are then displayed.



Highlighting Text and Numbers

To highlight only numbers in a sheet:

e Select all the data in the table.

e Press F5 and a window will pop up. Then click on Special.
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e Select Constants, tick Numbers, and click on OK.
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e The numbers will be highlighted.

e Then go to fill color to apply to the highlighted numbers

# Product 1 | 5247.00 USA

2 |product2 | $168.00 | France

3 |pProduct3 | Canada UK

4 |Product4 $129.00 | $156.00

5 |Products $133.00 | India

6 |Product6 USA $227.00

F Product 7 5156.00 | France

8  |Product8 India | S578.00 |

To highlight only text:

e Select all the data in the table
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e Select Constants, tick Texts, and click on OK.
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e Here on this page, the text will be highlighted.



Product 1 5247.00 USA
Product 2 | $168.00 | France
Product 3 Canada UK
Product 4 $129.00 5156.00
Product 5 $133.00 India
Product 6 UsSA $227.00
Product 7 5156.00 | France
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e Go to fill color to apply to the highlighted numbers.

1 ‘huduul $247.00 USA

2 |product2 5168.00 | France
3 |productl | Canada UK

4 |Productd | $129.00 | $156.00
5 |Product5 00| India

6 ‘mi $227.00
7  |Product? | S5156.00| France
8 |products | india | $578.00




Highlighting Cells That Have Formulas

To highlight the cells that have formulas:
e On the table that has all the cells, press the buttons Ctrl + G.

e A window will pop up. Click on Special.
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e In the next window that pops up, select Formula and press OK.

e The cell with formulas will be selected or highlighted.






Getting Data from the Internet

You can also get live data into your Excel sheet. To do this:

e Open any of your Internet browsers and go to the website you need
to get the data from.
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e Copy the URL link from the website.
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From File
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From Database

- From Azure

e Select Get Data
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— Launch Power Query Editor i

'3 Data Catalog Search
(w) My Data Catalog Queries @ From SharePoint List

-» Data Source Settings.
B From OData Feed
Query Options

T

1 < From Hadoap File (HDFS)

1) @® From Active Directory

e Go back to Excel, go to Data, and select From Web.

e Paste the copied URL and select OK.
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e A window will pop up showing you the list of data on the web page.
Select the data you want and then click on Load.

e The data will be displayed in the Excel Worksheet.



Chapter 10: Basics of Microsoft Word

Microsoft Word, referred to simply as “Word”, is a word processing
programming and a leading product of Microsoft.

It is a very successful application of Microsoft Office and is the most
generally utilized word processor in the world. In fact, Microsoft Word is
used in a billion gadgets all around the world.

First delivered in 1983 under an alternate name, Microsoft Word celebrated
its 25th birthday in the year 2018. Its success lies in its usability, in addition
to the fact that it can be utilized on various frameworks including Macintosh
and, obviously, Windows.

Word can be purchased as an independent item or as a piece of Microsoft
Office, which additionally incorporates programs like Excel and PowerPoint.

Let us understand exactly how Word came to rule the market during the most
recent 25 years and became the most-utilized word processing programming
in the world. What's more, what does the future hold for it?



Ascent to Fame

The first historical adaptation of Microsoft Word, Word 1.0, was released in
October 1983 and created by previous Xerox developers, Charles Simonyi
and Richard Brodie. The two were employed by Microsoft organizers Bill
Gates and Paul Allen in 1981. At that point, Word was called Multi-Tool
Word. It was intended for use on PCs that ran the UNIX framework.

Word was a WYSIWYG (‘what you see is what that you get') program. This
implied that any way a report looked on screen was the way it would look
once printed. Word let clients make, save, and print text documents, however
it was definitely not an achievement that happened instantaneously, maybe
due to the fact that it was rivaling the massively well known WordPerfect and
WordStar word processing programs at the time.

Variant 2.0 was released in 1985, with added highlights including spell check
and word tally.

Throughout the following years, Microsoft re-coded the program on various
occasions with the goal that it could be used with various working
frameworks, including DOS and Macintosh. The name was additionally
changed to the more limited and more apt “Word”.

In 1993, Microsoft delivered Word 6.0 which dealt with Macintosh,
Windows, and DOS. Word 6.0 was the last form made to run on DOS and the
last form to be recognized by rendition number; resulting variants were
named after their year of release.

From that point forward, Microsoft has delivered another rendition of Word
at regular intervals, with new changes and developments that only improve it.
The latest delivery was toward the end of 2018, Word 2019, which was a part
of Office 365.



The Eventual Fate of Word

Today, Word and the entire Office suite is profoundly incorporated and runs
on OS X, Android and iOS, as well as Windows. Satya Nadella, CEO of
Microsoft, has said that Office is the organization's most significant API.

The most recent form of the product is Word 2019. Like its accounting
application, Excel, Word has been given various updates to improve its
usefulness and guarantee it stays aware of the changing times and adapts to
the needs of the user.



New Highlights of Word

Translator

Word would now be able to make an interpretation of words and sentences
into different dialects utilizing the Microsoft Translator, which can be found
under the Review tab. This capacity has additionally been added to Excel,
OneNote and PowerPoint.

Learning Tools

This element helps make your documents simple to understand and use with
simplicity. Use it to change section width for improved center, page tone so
the page can be examined with less strain to the eye, and show breaks
between syllables to improve word acknowledgment and elocution.

Digital Pen

In the event that you have a touch-screen gadget, the most recent variant of
Word (and other Office items) allows you to draw with your finger, a mouse
or a digital pen for simple comment and note-taking.

Symbols and SVGs (scalable vector graphics)

Word presently has a library of symbols and 3D pictures which can be used
and inserted into documents to make them all the more outwardly engaging
and to have an effect. Clients can change tones and apply impacts, as well.



Some Basics about Microsoft Word

Microsoft Word can be found in the Start menu under Microsoft Office. Click
on All programs and then scroll to the Microsoft Office folder

You’ll need a computer with Microsoft Word installed. Follow these step-by-
step instructions to create a document in Microsoft Word. From the desktop,
or from your Start menu, open Microsoft Word by clicking on All programs
and navigating through to Microsoft Word as below.

Microsoft Word will open up and present a blank document ready for you to
start typing whatever it is you desire.

Qs

AaB




The flashing cursor (mouse pointer) in the document tells you where you’re
typing. Wherever the flashing cursor is placed, the letters that you type will
be inserted at that point. When you start a new blank document, the flashing
cursor will be at the start of your document ready for you to start typing and
creating content.
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When you type, the cursor will also move with each letter. This guides you so
that you know where the focus lies for typing.
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The mouse can be used for moving around a document. When the mouse
pointer is moved over a certain text area, the pointer will change from an
arrow to a “text select” or “I-beam” icon.



Move the text select/mouse pointer with your mouse to where you would like
to alter or add text. Click the left-hand button on the mouse. This will then
place the flashing cursor at the point where you have clicked so that you can
modify or insert text.

You can also move around your current document using the arrow keys on
the keyboard.

Pressing on these arrow keys will move the flashing cursor up a line of text,
down a line, or left one character or right one character. Using a combination
of keystrokes can also move the cursor further — e.g. holding down the Ctrl
key and pressing the left arrow key will move the cursor left one word.
Holding down Citrl and pressing the up arrow key will move the cursor to the
start of each desired paragraph.



How to Select Text in a Document

If you are not in a Word document, you will need to open it. From the
desktop or from your Start menu, open Microsoft Word.

Click the File button in the top left. Select Open and browse to the document
you wish to open. Then, double-click on the file name to open.

The mouse can be used to select the desired text. When the mouse pointer is
moved over a text area, the pointer will change from an arrow to an I-beam or
text select icon.

Move the text select or mouse pointer with your mouse to wherever you’d
like to start your selection. Click and hold down the left mouse button. While
doing this, move the mouse across your text to where you’d like the selection
to stop. As you move the mouse, the text will be selected. When you’ve
finished your selection, release the left mouse button.

The selected and highlighted text can now be formatted or changed if
required.

You can also move and select text using the arrow keys on the keyboard,
which some people may find easier than using the mouse.

If you use a combination of keyboard keys (e.g. holding down Ctrl + Shift
and pressing the left or right arrow key), you can move the cursor and select
the text in different directions.

Once text is selected (highlighted), it can be changed or edited as required.



How to Change Text Size and Font

Open an existing Microsoft Word document or start a new document and
type your text.

If you’d like to change a portion of the text to a different font, it will need to
be selected or highlighted first. When the mouse pointer is moved over a text
area, it will change from an arrow to a text select or I-beam icon.

Select your text so that it’s highlighted.

To change the font style, click the arrow next to the font style in the ribbon at
the top of your document.
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Choose your font style from the drop-down list given.

Next to the font style box is a box containing a number and an arrow. This
changes the size of the font. Click on the arrow.

Choose the size of font from the drop-down list of options.
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If you would like the same size and style of font set up every time you start a

new document, you can choose a default font. Click on the Font arrow right
above the main screen.
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A dialog box will pop-up. In this, you can choose your font size and style
from the options available.

Click Set as Default on the bottom left-hand corner of the dialog box.



Another dialog box will pop up asking if you really want to change the font
for all Word documents. Click on Yes. Now, whenever you open a new
document in Word, the default font will be used until you need to change it
again.



Printing a Document

To print any document, your computer needs to be connected to a printer,
otherwise it will not work.

Open an existing Word document or start a new document and type your text.

Once you have completed your document and are ready to print it, click File
in the top left-hand corner.

Move down and click on the Print option in the menu. This will bring up the
Print dialog box.

Choose the number of copies of your document you want.
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Depending on your printer options, you can choose other printing features
such as if you want to print all pages or only certain pages. You can also
change the orientation of the print from portrait to landscape and let your
computer and printer know whether you’re printing on a certain size of paper.

You’ll also see, on the right, a preview of how your printed document will
look.
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When you are satisfied with your settings, click on Print. The document will
now start printing from your connected printer.




How to Save a Document

It is good practice to regularly save your document as you are working on it.
This function means that your current document will be backed up on the
computer you are working on, in case your computer inexplicably shuts
down, which would result in losing your document if it is not saved.

There are several ways to save a document in Microsoft Word. The following
instructions will take you through the different options:

If you are saving a document for the very first time, on the Quick Access
Toolbar, click Save, or press the keys CTRL+S.
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Type a name for the desired document, and then click on Save. Word saves
the document in a default location. To save the document in a different or
specific location, select another folder in the list of folders displayed on the
screen.
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Save an Existing Document as a New Document
(Save As)

To prevent overwriting the original document, use the Save As command to
create a new file as soon as you open the original document.

Open the document that you want to save as a new file.
Click on the File tab.
Click on Save As.
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Type a unique name for the document, and then click on Save.
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Microsoft Word saves the document in a default location. To save the
document in a different location, click another folder in the Save in list (down
the left hand side) in the Save As dialog box. If you want to change the
default location where Word saves documents, adjust settings for saving
documents, as per your requirements.

Adjust the settings for saving documents
Click on the File tab.
Under Help, click on Options.

Click on Save.
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In the Save files in this format box, click the file format that you desire to
use.
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Next to the Default file location box, click on Browse, and then click the
folder where you want to save your files.
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These options control the default method the first time you use the Open,
Save, or Save As command when you start Word. Whenever you save a
document, you can override such settings by specifying a different location or
format in the Open, Save, or Save As dialog box that appears.



Conclusion

In this book, we learned some history of Microsoft and Microsoft Office,
along with basics of Microsoft Excel and Word. It is a beginner’s guide to
some tips and tricks of using both and understanding how your daily tasks
can be done much more easily because of Microsoft Excel.

Since its inception, Microsoft has given us various products and services that
have made revolutionary changes in the way people do business. It is still the
leading company in the field, and will continue to be so for years to come,
owing to the simplicity of the products and services.

Hopefully after reading this book, you have come to realize how important it
is to learn the basics of Excel. It makes things easier for us to understand
numbers and calculate data. This book was specifically prepared to help you
understand the basics of Microsoft Excel and Word, and be informative
enough to help beginners get the perfect guide for the basics.

After understanding the new features of Excel 2020, we can conclude that
Microsoft is still striving to improve its services for us so that we achieve the
best results.

No matter who you are, you will benefit equally from using the products
offered by Microsoft Office. There is no limit to the uses of these
applications and one can use them for anything, from calculating monthly
expenses to understanding the revenue streams for a business. You can use it
in any way to make your life easier!

Understanding the basics of both Excel and Word is important in the long
run, especially for students. These are the basics that one needs to know to
understand how things work now, as they have become a part of the modern
way of living.

Learning is never a waste of time, and in this day and age, learning the basics
of Microsoft Office is always beneficial. It teaches us how easily things can
be done and with every new version, it only makes things more simpler. Let
this information help you make your life as simple as it can be!
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